
 

Динамика течения и теплообмен в смешивающихся 

потоках воздуха (Пример из официальной документации) 

1.1. Introduction 

This tutorial illustrates the setup and solution of a three-dimensional turbulent fluid flow and heat 

transfer problem in a mixing elbow. The mixing elbow configuration is encountered in piping systems in 

power plants and process industries. It is often important to predict the flow field and temperature field 

in the area of the mixing region in order to properly design the junction. 

This tutorial demonstrates how to do the following: 

• Launch ANSYS Fluent. 

• Read an existing mesh file into ANSYS Fluent. 

• Use mixed units to define the geometry and fluid properties. 

• Set material properties and boundary conditions for a turbulent forced-convection problem. 

• Create a surface report definition and use it as a convergence criterion. 

• Calculate a solution using the pressure-based solver. 

• Visually examine the flow and temperature fields using the postprocessing tools available in 

ANSYS Fluent. 

• Adapt the mesh based on the temperature gradient to further improve the prediction of the 

temperature field. 

 1.3. Problem Description 

The problem to be considered is shown schematically in Figure 1.1: Problem Specification. A cold fluid at 

20° C flows into the pipe through a large inlet, and mixes with a warmer fluid at 40° C that enters 

through a smaller inlet located at the elbow. The pipe dimensions are in inches and the fluid properties 

and boundary conditions are given in SI units. The Reynolds number for the flow at the larger inlet is 

50,800, so a turbulent flow model will be required. 

Note:  Since the geometry of the mixing elbow is symmetric, only half of the elbow must be modeled in 

ANSYS Fluent. 



 

Figure 1.1: Problem Specification 

1.4. Setup and Solution 

To help you quickly identify graphical user interface items at a glance and guide you through the steps of 

setting up and running your simulation, the ANSYS Fluent Tutorial Guide uses several type styles and 

mini flow charts. See Typographical Conventions Used In This Manual for detailed information. 

 1.4.1. Preparation 

1. Download the introduction.zip file here. 

2. Unzip introduction.zip to your working directory. 

3. The elbow.msh can be found in the folder. 

 1.4.2. Launching ANSYS Fluent 

• From the Windows Start menu, select Start > ANSYS 2020 R1 > Fluent 2020 R1 to start Fluent 

Launcher. 

Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your 

geometry and on your processing capabilities. 



Ensure that the proper options are enabled.

• Select 3D from the Dimension

• Ensure that the Double Precision

• Ensure that the Display Mesh After Reading

• Set Processes to 4 under the

Note:   Fluent will retain your preferences for future sessions.

Set the working folder to the one created when you unzipped

• Click the Show More Options

• Enter the path to your working

typing. 

Alternatively, you can click the browse button (

to the directory, using the Browse For Folder

proper options are enabled. 

Dimension list by clicking the radio button or the text.

Double Precision option is selected. 

Display Mesh After Reading option is enabled. 

under the Parallel (local Machine). 

Fluent will retain your preferences for future sessions. 

Set the working folder to the one created when you unzipped introduction.zip

Show More Options button to reveal additional options. 

Enter the path to your working folder for Working Directory by double

Alternatively, you can click the browse button (  ) next to the Working Directory

Browse For Folder dialog box. 

 

list by clicking the radio button or the text. 

introduction.zip. 

by double-clicking the text box and 

Working Directory text box and browse 



Click OK to launch ANSYS Fluent.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in 

the Fluent Getting Started Guide.

  

ANSYS Fluent. 

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in 

the Fluent Getting Started Guide. 

 

 
For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in 



1.4.3. Reading the Mesh

• Read the mesh file elbow.msh

Click the File ribbon tab, then click

File dialog box. 

 File → Read → Mesh... 

• Select the mesh file by clicking

unzipped the original file.

• Enable the Display Mesh After Reading

• Click OK to read the file and close the

As the mesh file is read by ANSYS Fluent, messages will appear in the console reporting the pro

the conversion. ANSYS Fluent

number of boundary faces with different zone identifiers.

After having completed reading mesh, ANSYS Fluent displays the mesh in the graphics 

Manipulate the mesh display using the axis triad to obtain a front view as shown in

Hexahedral Mesh for the Mixing Elbow

1. Click the z-axis. 

2. Clicking the Fit to Window

window. 

3. Figure 1.2: The Hexahedral Mesh for the Mixing 

1.4.3. Reading the Mesh 

elbow.msh. 

ribbon tab, then click Read and Mesh... in the menus that open in order to open the

 

Select the mesh file by clicking elbow.msh in the introduction folder created when you 

unzipped the original file. 

Display Mesh After Reading in the Select File dialog box. 

to read the file and close the Select File dialog box. 

As the mesh file is read by ANSYS Fluent, messages will appear in the console reporting the pro

the conversion. ANSYS Fluent will report that 13,852 hexahedral fluid cells have been read, along with a 

number of boundary faces with different zone identifiers. 

After having completed reading mesh, ANSYS Fluent displays the mesh in the graphics 

Manipulate the mesh display using the axis triad to obtain a front view as shown in

Hexahedral Mesh for the Mixing Elbow. 

Fit to Window icon,  , will cause the object to fit exactly and be centered in the 

Figure 1.2: The Hexahedral Mesh for the Mixing Elbow 

in the menus that open in order to open the Select 

 
folder created when you 

As the mesh file is read by ANSYS Fluent, messages will appear in the console reporting the progress of 

will report that 13,852 hexahedral fluid cells have been read, along with a 

After having completed reading mesh, ANSYS Fluent displays the mesh in the graphics window. 

Manipulate the mesh display using the axis triad to obtain a front view as shown in Figure 1.2: The 

, will cause the object to fit exactly and be centered in the 



 
Figure 1.2: The Hexahedral Mesh for the Mixing Elbow 

 
  

1.4.4. Setting Up Domain 

In this step, you will perform the mesh-related activities using the Domain ribbon tab (Mesh group box). 

 
1. Check the mesh. 

 Domain → Mesh → Check → Perform Mesh Check 

ANSYS Fluent will report the results of the mesh check in the console. 

 Domain Extents: 

   x-coordinate: min (m) = -8.000000e+00, max (m) = 

8.000000e+00 

   y-coordinate: min (m) = -9.134634e+00, max (m) = 

8.000000e+00 

   z-coordinate: min (m) = 0.000000e+00, max (m) = 

2.000000e+00 

 Volume statistics: 

   minimum volume (m3): 5.098304e-04 

   maximum volume (m3): 2.330736e-02 

     total volume (m3): 1.607154e+02 

 Face area statistics: 

   minimum face area (m2): 4.865882e-03 



   maximum face area (m2): 1.017924e-01 

 Checking mesh.................................... 

Done. 

The mesh check will list the minimum and maximum x, y, and z values from the mesh in the default SI 

unit of meters. It will also report a number of other mesh features that are checked. Any errors in the 

mesh will be reported at this time. Ensure that the minimum volume is not negative, since ANSYS Fluent 

cannot begin a calculation when this is the case. 

Note:  The minimum and maximum values may vary slightly when running on different platforms. 

2. Scale the mesh. 

•  Domain → Mesh → Scale... 

 
 Ensure that Convert Units is selected in the Scaling group box. 

1. From the Mesh Was Created In drop-down list, select in by first clicking the down-arrow button 

and then clicking the in item from the list that appears. 

2. Click Scale to scale the mesh. 

3. Warning:  Be sure to click the Scale button only once. 

Domain Extents will continue to be reported in the default SI unit of meters. 

4. Select in from the View Length Unit In drop-down list to set inches as the working unit for 

length. 

5. Confirm that the domain extents are as shown in the previous dialog box. 

6. Close the Scale Mesh dialog box. 

Right click in the graphics window and select Refresh Display 



Clicking the Fit to Window icon,

window. 

1. Check the mesh. 

 Domain → Mesh → Check

Note:  It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, 

merge, separate, fuse, add zones, or smooth and swap). This will ensure

not been compromised. 

1.4.5. Setting Up Physics

In the steps that follow, you will select a solver and specify physical models, material properties, and 

zone conditions for your simulation using the

In the Solver group box of the

based solver. 

 Physics → Solver → General

icon,  , will cause the object to fit exactly and be centered in the 

Check → Perform Mesh Check 

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, 

merge, separate, fuse, add zones, or smooth and swap). This will ensure that the quality of the mesh has 

1.4.5. Setting Up Physics 

In the steps that follow, you will select a solver and specify physical models, material properties, and 

zone conditions for your simulation using the Physics ribbon tab. 

group box of the Physics ribbon tab, retain the default selection of the steady pressure

General 

 

the object to fit exactly and be centered in the 

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to polyhedra, 

that the quality of the mesh has 

In the steps that follow, you will select a solver and specify physical models, material properties, and 

ribbon tab, retain the default selection of the steady pressure-



 
Set up your models for the CFD simulation using the Models group box of the Physics ribbon tab. 

 
Note:  You can also use the Models task page, which can be accessed from the tree by 

expanding Setup and double-clicking the Models tree item. 

2. Enable heat transfer by activating the energy equation. 

In the Physics ribbon tab, enable Energy (Models group box). 

 Physics → Models → Energy 

3. Enable the k-ω turbulence model. 

 Physics → Models → Viscous... 



 
4. Retain the default selection of k-omega from the Model list. 

5. Retain the default selection of SST in the k-omega Model group box. 

6. Click OK to accept all the other default settings and close the Viscous Model dialog box. 

7. Note that the Viscous... label in the ribbon is displayed in blue to indicate that the Viscous 

model is enabled. Also Energy and Viscous appear as enabled under the Setup/Models tree 

branch. 

Set up the materials for the CFD simulation using the Materials group box of the Physics ribbon tab. 

 
Create a new material called water using the Create/Edit Materials dialog box. 



In the Physics ribbon tab, click Create/Edit... (Materials group box). 

 Physics → Materials → Create/Edit... 

 
Click the Fluent Database... button to access pre-defined materials. 

Select water-liquid (h2o < l >) from the materials list and click Copy, then close the Fluent 

Database... dialog box. 

 



Ensure that there are now two materials (water-liquid and air) defined locally by examining the Fluent 

Fluid Materials drop-down list. 

Both the materials will also be listed under Fluid in the Materials task page and under the Materials tree 

branch. 

Close the Create/Edit Materials dialog box. 

Set up the cell zone conditions for the fluid zone (fluid) using the Zones group box of the Physics ribbon 

tab. 

 
In the Physics tab, click Cell Zones (Zones group box). 

 Physics → Zones → Cell Zones 

This opens the Cell Zone Conditions task page. 

 
Double-click fluid in the Zone list to open the Fluid dialog box. 



 
Select water-liquid from the Material Name drop-down list. 

Click OK to close the Fluid dialog box. 

Set up the boundary conditions for the inlets, outlet, and walls for your CFD analysis using 

the Zones group box of the Physics ribbon tab. 

 
In the Physics tab, click Boundaries (Zones group box). 

 Physics → Zones → Boundaries 

This opens the Boundary Conditions task page where the boundaries defined in your simulation are 

displayed in the Zone selection list. 



 
Here the zones have names with numerical identifying tags. It is good practice to give boundaries 

meaningful names in a meshing application to help when you set up the model. You can also change 

boundary names in Fluent by simply editing the boundary and making revisions in the Zone Name text 

box. 

Set the boundary conditions at the cold inlet (velocity-inlet-5). 

Double-click velocity-inlet-5 to open the Velocity Inlet dialog box. 



 
• Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification 

Method drop-down list. 

• Enter 0.4 [m/s] for Velocity Magnitude. 

• In the Turbulence group box, select Intensity and Hydraulic Diameter from the Specification 

Method drop-down list. 

• Retain the default value of 5 [%] for Turbulent Intensity. 

• Enter 4 [inches] for Hydraulic Diameter. 

• Click the Thermal tab. 

 
• Enter 293.15 [K] for Temperature. 

• Click OK to close the Velocity Inlet dialog box. 

In a similar manner, set the boundary conditions at the hot inlet (velocity-inlet-6), using the values in 

the following table: 



Setting Value 

Velocity Specification Method Magnitude, Normal to Boundary 

Velocity Magnitude 1.2 [m/s] 

Specification Method Intensity and Hydraulic Diameter 

Turbulent Intensity 5 [%] 

Hydraulic Diameter 1 [inch] 

Temperature 313.15 [K] 

Double-click pressure-outlet-7 in the Zone selection list and set the boundary conditions at the outlet, 

as shown in the following figure. 

 
For the wall of the pipe (wall), retain the default value of 0 W/m2 for Heat Flux in the Thermal tab. 



 
  

1.4.6. Solving 

In the steps that follow, you will set up and run the calculation using the Solution ribbon tab. 

• Select a solver scheme. 

• In the Solution ribbon tab, click Methods... (Solution group box). 

 

 Solution → Solution → Methods... 



 
Retain the default selections. 

Enable the plotting of residuals during the calculation. 

In the Solution ribbon tab, click Residuals... (Reports group box). 

 

 Solution → Reports → Residuals... 



 
• Ensure that Plot is enabled in the Options group box. 

• Retain the default value of 0.001 for the Absolute Criteria of continuity. 

• Click OK to close the Residual Monitors dialog box. 

Create a surface report definition of average temperature at the outlet (pressure-outlet-7). 

 Solution → Reports → Definitions → New → Surface Report → Mass-Weighted Average... 

 
• Enter outlet-temp-avg for the Name of the report definition. 

• Enable Report File, Report Plot, and Print to Console in the Create group box. 



During a solution run, ANSYS Fluent will write solution convergence data in a report file, plot the 

solution convergence history in a graphics window, and print the value of the report definition to the 

console. 

• Set Frequency to 3 by clicking the up-arrow button. 

This setting instructs ANSYS Fluent to update the plot of the surface report, write data to a file, and print 

data in the console after every 3 iterations during the solution. 

• Select Temperature... and Static Temperature from the Field Variable drop-down lists. 

• Select pressure-outlet-7 from the Surfaces selection list. 

• Click OK to save the surface report definition and close the Surface Report Definition dialog box. 

• The new surface report definition outlet-temp-avg will appear under the Solution/Report 

Definitions tree item. ANSYS Fluent also automatically creates the following items: 

• outlet-temp-avg-rfile (under the Solution/Monitors/Report Files tree branch) 

• outlet-temp-avg-rplot (under the Solution/Monitors/Report Plots tree branch) 

• In the tree, double-click outlet-temp-avg-rfile (under Solution/Monitors/Report Files) and 

examine the report file settings in the Edit Report File dialog box. 

 
The dialog box is automatically populated with data from the outlet-temp-avg report definition. 

Verify that outlet-temp-avg is in the Selected Report Definitions list. 

If you had created multiple report definitions, the additional ones would be listed under Available 

Report Definitions, and you could use the Add>> and <<Remove buttons to manage which were written 

in this particular report definition file. 

• (optional) Edit the name and location of the resulting file as necessary using the File Name field 

or Browse... button. 



• Click OK to close the Edit Report File dialog box. 

• Create a convergence condition for outlet-temp-avg. 

 Solution → Reports → Convergence... 

 
• Click the Add button. 

• Enter con-outlet-temp-avg for Conditions. 

• Select outlet-temp-avg from the Report Definition drop-down list. 

• Enter 1e-5 for Stop Criterion. 

• Enter 20 for Ignore Iterations Before. 

• Enter 15 for Use Iterations. 

• Enable Print. 

• Set Every Iteration to 3. 

• Click OK to save the convergence condition settings and close the Convergence 

Conditions dialog box. 

These settings will cause Fluent to consider the solution converged when the surface report definition 

value for each of the previous 15 iterations is within 0.001% of the current value. Convergence of the 

values will be checked every 3 iterations. The first 20 iterations will be ignored, allowing for any initial 

solution dynamics to settle out. Note that the value printed to the console is the deviation between the 

current and previous iteration values only. 

• Initialize the flow field using the Initialization group box of the Solution ribbon tab. 

 Solution → Initialization 



• Retain the default selection of

• Click Initialize. 

Save the case file (elbow1.cas.h5

 File → Write → Case... 

• (optional) Indicate the folder in which you would like the file to be saved.

By default, the file will be saved in the folder from which you read in

the introduction folder). 

folder. 

• Enter elbow1.cas.h5

• Ensure that the default

• Click OK to save the case file and cl

• Start the calculation by requesting 150 iterations in the

Calculation group box).

 Solution → Run Calculation

Retain the default selection of Hybrid from the Method list. 

elbow1.cas.h5). 

 

(optional) Indicate the folder in which you would like the file to be saved.

By default, the file will be saved in the folder from which you read in elbow.msh

folder). You can indicate a different folder by browsing to it or by creating a new 

elbow1.cas.h5 for Case File. 

Ensure that the default Write Binary Files option is enabled, so that a binary file will be written.

to save the case file and close the Select File dialog box. 

Start the calculation by requesting 150 iterations in the Solution ribbon tab (

group box). 

Run Calculation 

 

 
(optional) Indicate the folder in which you would like the file to be saved. 

elbow.msh (that is, 

You can indicate a different folder by browsing to it or by creating a new 

option is enabled, so that a binary file will be written. 

ribbon tab (Run 



 

• Enter 150 for No. of Iterations. 

• Click Calculate. 

As the calculation progresses, the surface report history will be plotted in the outlet-temp-avg-rplot tab 

in the graphics window (Figure 1.3: Convergence History of the Mass-Weighted Average Temperature). 

 
Figure 1.3: Convergence History of the Mass-Weighted Average Temperature 

 
Similarly, the residuals history will be plotted in the Scaled Residuals tab in the graphics window 

(Figure 1.4: Residuals). 

 
Figure 1.4: Residuals 

Since the residual values vary slightly by platform, the plot that appears on your screen may not be 

exactly the same as the one shown here. 

The solution will be stopped by ANSYS Fluent when any of the following occur: 



• the surface report definition converges to within the tolerance specified in the Convergence 

Conditions dialog box 

• the residual monitors converge to within the tolerances specified in the Residual 

Monitors dialog box 

• the number of iterations you requested in the Run Calculation task page has been reached 

In this case, the solution is stopped when the convergence criterion on outlet temperature is satisfied. 

The exact number of iterations for convergence will vary, depending on the platform being used. 

An Information dialog box will open to alert you that the calculation is complete. Click OK in 

the Information dialog box to proceed. 

Examine the mass flux report for convergence using the Results ribbon tab. 

 Results → Reports → Fluxes... 

 
• Ensure that Mass Flow Rate is selected from the Options list. 

• Select pressure-outlet-7, velocity-inlet-5, and velocity-inlet-6 from the Boundaries selection list. 

• Click Compute. 

The individual and net results of the computation will be displayed in the Results and Net Results boxes, 

respectively, in the Flux Reports dialog box, as well as in the console. 

The sum of the flux for the inlets should be very close to the sum of the flux for the outlets. The net 

results show that the imbalance in this case is well below the 0.2% criterion suggested previously. 

Close the Flux Reports dialog box. 

Save the data file (elbow1.dat.h5). 

 File → Write → Data... 

In later steps of this tutorial you will save additional case and data files with different suffixes. 

  



1.4.7. Displaying the Preliminary Solution

In the steps that follow, you will visualize various aspects of the flow for the 

the Results ribbon tab. 

Display filled contours of velocity magnitude on the symmetry plane 

(Figure 1.5: Predicted Velocity Distribution after the Initial Calculation

 Results → Graphics → Contours

• Enter contour-vel

• Enable Filled in the Options

• Ensure that Node Values

• Select Banded in the 

• Select Velocity... and

• Select symmetry from the

• Click Save/Display to display the contours in the active graphics window. Clicking the

Window icon (  ) will cause the object to fit exactly and be centered in the window.

Close the Contours dialog box.

1.4.7. Displaying the Preliminary Solution 

In the steps that follow, you will visualize various aspects of the flow for the preliminary solution using 

Display filled contours of velocity magnitude on the symmetry plane 

Predicted Velocity Distribution after the Initial Calculation

Contours → New... 

vel for Contour Name. 

Options group box. 

Node Values and Boundary Values are enabled in the Options

 Coloring group box. 

and Velocity Magnitude from the Contours of drop-

from the Surfaces selection list. 

to display the contours in the active graphics window. Clicking the

) will cause the object to fit exactly and be centered in the window.

dialog box. 

preliminary solution using 

Display filled contours of velocity magnitude on the symmetry plane 

Predicted Velocity Distribution after the Initial Calculation). 

 

Options group box. 

-down lists. 

to display the contours in the active graphics window. Clicking the Fit to 

) will cause the object to fit exactly and be centered in the window. 



 View → Display 

 
Disable the Headlight and Lighting options. 

 
Figure 1.5: Predicted Velocity Distribution after the Initial Calculation 

Create and display a definition for temperature contours on the symmetry plane (Figure 1.6: Predicted 

Temperature Distribution after the Initial Calculation). 

 Results → Graphics → Contours → New... 

You can create contour definitions and save them for later use. 



 
• Enter contour-temp for Contour Name. 

• Select Temperature... and Static Temperature from the Contours of drop-down lists. 

• Select symmetry from the Surfaces selection list. 

• Click Save/Display and close the Contours dialog box. 

The new contour-temp definition appears under the Results/Graphics/Contours tree branch. To edit 

your contour definition, right-click it and select Edit... from the menu that opens. 

Display velocity vectors on the symmetry plane (Figure 1.9: Magnified View of Resized Velocity Vectors). 

 Results → Graphics → Vectors → New... 

 



 

Figure 1.6: Predicted Temperature Distribution after the Initial Calculation 

 

 
• Enter vector-vel for Vector Name. 



• Select arrow from the Style drop-down box. 

• Select symmetry from the Surfaces selection list. 

• Click Save/Display to plot the velocity vectors. 

 
Figure 1.7: Velocity Vectors Colored by Velocity Magnitude 

The Auto Scale option is enabled by default in the Options group box. This scaling sometimes creates 

vectors that are too small or too large in the majority of the domain. You can improve the clarity by 

adjusting the Scale and Skip settings, thereby changing the size and number of the vectors when they 

are displayed. 

• Enter 4 for Scale. 

• Set Skip to 2. 

• Click Save/Display again to redisplay the vectors. 



 
Figure 1.8: Resized Velocity Vectors 

 
• Close the Vectors dialog box. 

• Zoom in on the vectors in the display. 

To manipulate the image, refer to Table 1.1: View Manipulation Instructions. The image will be 

redisplayed at a higher magnification (Figure 1.9: Magnified View of Resized Velocity Vectors). 

 
Figure 1.9: Magnified View of Resized Velocity Vectors 

 
• Zoom out to the original view. 



Clicking the Fit to Window icon,

window. 

Create a line at the centerline of the outlet. For this task, you will use the

the Results tab. 

 Results → Surface → Create

• Enter z=0_outlet 

• Select Mesh... and Z-

• Click Compute to obtain the extent of the mesh in the 

• The range of values in the z

• Retain the default value of

• Select pressure-outlet

• Click Create. 

The new line surface representing 

outlet-7 is created, and its name

Close the Iso-Surface dialog box.

Display and save an XY plot of the temperature profile across the 

solution (Figure 1.10: Outlet Temperature Profile for the Initial Solution

 Results → Plots → XY Plot

icon,  , will cause the object to fit exactly and be centered in the 

line at the centerline of the outlet. For this task, you will use the Surface

 

Create → Iso-Surface... 

 for New Surface Name. 

Coordinate from the Surface of Constant drop-down lists.

to obtain the extent of the mesh in the z-direction. 

The range of values in the z-direction is displayed in the Min and Max

Retain the default value of 0 inches for Iso-Values. 

outlet-7 from the From Surface selection list. 

The new line surface representing the intersection of the plane z=0 and the surface

is created, and its name z=0_outlet appears in the From Surface selection list.

dialog box. 

Display and save an XY plot of the temperature profile across the centerline of the outlet for the initial 

Outlet Temperature Profile for the Initial Solution). 

XY Plot → New... 

, will cause the object to fit exactly and be centered in the 

Surface group box of 

 

down lists. 

Max fields. 

 

the intersection of the plane z=0 and the surface pressure-

selection list. 

centerline of the outlet for the initial 



 

• Enter xy-outlet-temp for XY Plot Name. 

• Select Temperature... and Static Temperature from the Y Axis Function drop-down lists. 

• Select the z=0_outlet surface you just created from the Surfaces selection list. 

• Click Save/Plot. 

• Enable Write to File in the Options group box. 

The button that was originally labeled Save/Plot will change to Write.... 

• Click Write.... 

• In the Select File dialog box, enter outlet_temp1.xy for XY File. 

• Click OK to save the temperature data and close the Select File dialog box. 

• Close the Solution XY Plot dialog box. 

 
Figure 1.10: Outlet Temperature Profile for the Initial Solution 

 



Define a custom field function for the dynamic head formula. 

 User-Defined → Field Functions → Custom... 

 
 Select Density... and Density from the Field Functions drop-down lists, and click the Select button to 

add density to the Definition field. 

Click the X button to add the multiplication symbol to the Definition field. 

Select Velocity... and Velocity Magnitude from the Field Functions drop-down lists, and click 

the Select button to add |V| to the Definition field. 

Click y^x to raise the last entry in the Definition field to a power, and click 2 for the power. 

Click the / button to add the division symbol to the Definition field, and then click 2. 

Enter dynamic-head for New Function Name. 

Click Define and close the Custom Field Function Calculator dialog box. 

The dynamic-head tree item will appear under the Parameters & Customization/Custom Field 

Functions tree branch. 

Display filled contours of the custom field function (Figure 1.11: Contours of the Dynamic Head Custom 

Field Function). 

 Results → Graphics → Contours → New... 



 
 Enter contour-dynamic-head for Contour Name. 

Select Banded in the Coloring group box. 

Select Custom Field Functions... and dynamic-head from the Contours of drop-down lists. 

Select symmetry from the Surfaces selection list. 

Click Save/Display and close the Contours dialog box. 



 
 
Figure 1.11: Contours of the Dynamic Head Custom Field Function 

Save the settings for the custom field function by writing the case and data files 

(elbow1.cas.h5 and elbow1.dat.h5). 

 File → Write → Case & Data... 

Ensure that elbow1.cas.h5 is entered for Case/Data File. 

Note:  When you write the case and data file at the same time, it does not matter whether you specify 

the file name with a .cas.h5 or .dat.h5 extension, as both will be saved. 

Click OK to save the files and close the Select File dialog box. 

Click OK to overwrite the files that you had saved earlier. 

 1.4.8. Adapting the Mesh 

For the first run of this tutorial, you have solved the elbow problem using a fairly coarse mesh. The 

elbow solution can be improved further by refining the mesh to better resolve the flow details. ANSYS 

Fluent provides a built-in capability to easily adapt (locally refine) the mesh according to solution 

gradients. In the following steps you will adapt the mesh based on the temperature gradients in the 

current solution and compare the results with the previous results. 

Define Cell Registers to Adapt the mesh in the regions of high temperature gradient. 

 Solution → Cell Registers  New → Field Variable... 



 

 
• Select Cells More Than from the Type drop-down list. 

• Select Curvature from the Derivative Option drop-down list. 

• Select Temperature... and Static Temperature from the Curvature of drop-down list. 

• Click Compute. 

ANSYS Fluent will update the Min and Max values to show the minimum and maximum temperature 

gradient. 

Enter a value of 0.003 for the Cells having value more than. 



A general rule is to use 10% of the maximum gradient when setting the value for refinement. 

Click Save and close the Field Variable Register daialog box. 

Setup mesh adaption using the Cell Registers. For this task, you will use the Adapt group box in 

the Domain ribbon tab. 

 

 Domain → Adapt → Refine / Coarsen... 

 
Select the previously defined curvature_0 cell register from the Refinement Criterion drop-down list. 

ANSYS Fluent will not coarsen beyond the original mesh for a 3D mesh. Hence, it is not necessary to 

select the Coarsening Criterion in this instance. 

Click Adapt. 

Click Display. 

ANSYS Fluent will display the cells marked for adaption in the graphics window (Figure 1.12: Cells 

Marked for Adaption). 



 
 

Figure 1.12: Cells Marked for Adaption 

 
Extra  —  You can change the way ANSYS Fluent displays cells marked for adaption 

(Figure 1.13: Alternative Display of Cells Marked for Adaption) by performing the following steps: 

Click Display Options... in the Adaption Controls dialog box to open the Display Options - Adaption dialog 

box. 

 
Enable Draw Mesh in the Options group box. 

The Mesh Display dialog box will open. 



 
• Ensure that only the Edges option is enabled in the Options group box. 

• Select Feature from the Edge Type list. 

• Select all of the items except z=0_outlet from the Surfaces selection list. 

• Click Display and close the Mesh Display dialog box. 

• Click OK to close the Display Options - Adaption dialog box. 

• Click Display in the Adaption Controls dialog box. 

• Rotate the view and zoom in to get the display shown in Figure 1.13: Alternative Display of Cells 

Marked for Adaption. 

 
Figure 1.13: Alternative Display of Cells Marked for Adaption 

 



After viewing the marked cells, rotate the view back and zoom out again. 

Click OK to close the Adaption Controls dialog box. 

Display the adapted mesh (Figure 1.14: The Adapted Mesh). 

 Domain → Mesh → Display... 

 

• Select All from the Edge Type list. 

• Deselect all of the highlighted items from the Surfaces selection list except for symmetry. 

Click Display and close the Mesh Display dialog box. 

 
Figure 1.14: The Adapted Mesh 

 
Request an additional 90 iterations. 

 Solution → Run Calculation → Calculate 



 
The solution will converge as shown in Figure 1.15: The Complete Residual 

History and Figure 1.16: Convergence History of Mass-Weighted Average Temperature. 

 

Figure 1.15: The Complete Residual History 

 

 
Figure 1.16: Convergence History of Mass-Weighted Average Temperature 

 
Save the case and data files for the Coupled solver solution with an adapted mesh 

(elbow2.cas.h5 and elbow2.dat.h5). 

 File → Write → Case & Data... 



Enter elbow2.h5 for Case/Data File. 

Click OK to save the files and close the Select File dialog box. 

The files elbow2.cas.h5 and elbow2.dat.h5 will be saved in your default folder. 

Display the temperature distribution (using node values) on the revised mesh using the temperature 

contours definition that you created earlier (Figure 1.17: Filled Contours of Temperature Using the 

Adapted Mesh). 

Right-click the Results/Graphics/Contours/contour-temp tree item and select Display from the menu 

that opens. 

 Results → Graphics → Contours → contour-temp  Display 

 

Figure 1.17: Filled Contours of Temperature Using the Adapted Mesh 

Display and save an XY plot of the temperature profile across the centerline of the outlet for the 

adapted solution (Figure 1.18: Outlet Temperature Profile for the Adapted Coupled Solver Solution). 

 Results → Plots → XY Plot → xy-outlet-temp  Edit... 

Click Save/Plot to display the XY plot. 



 
Figure 1.18: Outlet Temperature Profile for the Adapted Coupled Solver Solution 

 
Enable Write to File in the Options group box. 

The button that was originally labeled Save/Plot will change to Write.... 

Click Write.... 

In the Select File dialog box, enter outlet_temp2.xy for XY File. 

Click OK to save the temperature data. 

Close the Solution XY Plot dialog box. 

Display the outlet temperature profiles for both solutions on a single plot (Figure 1.19: Outlet 

Temperature Profiles for the Two Solutions). 

Open the Plot Data Sources dialog box. 

 Results → Plots → Data Sources... 



 
Click the Load File... button to open the Select File dialog box. 

 
Select outlet_temp1.xy and outlet_temp2.xy. 

Each of these files will be listed with their folder path in the bottom list to indicate that they have been 

selected. 

Click OK to save the files and close the Select File dialog box. 

Select the folder path ending in outlet_temp1.xy from the Curve Information selection list 

(Curves group box). 

Enter Before Adaption in the lower-right text-entry box. 

Click the Change Legend Entry button. 



The item in the Legend Entries list for outlet_temp1.xy will be changed to Before Adaption. This legend 

entry will be displayed in the upper-left corner of the XY plot generated in a later step. 

In a similar manner, change the legend entry for the folder path ending in outlet_temp2.xy to 

be Adapted Mesh. 

Click Plot and close the Plot Data Sources dialog box. 

Figure 1.19: Outlet Temperature Profiles for the Two Solutions shows the two temperature profiles at 

the centerline of the outlet. It is apparent by comparing both the shape of the profiles and the predicted 

outer wall temperature that the solution is highly dependent on the mesh and solution options. 

Specifically, further mesh adaption should be used in order to obtain a solution that is independent of 

the mesh. 

 

Figure 1.19: Outlet Temperature Profiles for the Two Solutions 

  

1.5. Summary 

The solution results are changed by the adaption of the mesh, which indicates that a sufficiently refined 

mesh is required to obtain a mesh independent solution. 

 


